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Preface 

Warranty 

Miranda Technologies Ltd offer a 24 months free parts and labour warranty 

on Oxtel Series equipment from the date of the initial invoice, providing 

there is no evidence of negligence, abuse or failure to reasonably follow 

instructions given by the Company for its proper use. 

 

During the warranty period, Miranda Technologies Ltd will replace or repair 

at its cost, Oxtel Series equipment returned to the factory, carriage and duty 

paid and insured by the sender. 

 

Before returning any item for warranty repair, a valid returns authorisation 

must be granted by Miranda Technologies Ltd. 

 

All repaired goods will be delivered (as instructed) carriage and duty paid 

and insured by the sender. 

 

Any warranty, over and above that offered here, is the responsibility of the 

local Miranda Sales Office or appointed Distributor. 

 

 

Contact Information 

For service, repair and warranty information and for returns authorisation 

contact: 

oxtelsupport@miranda.com  
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Associated Publications 

 

Description    Part number 

Imagestore 2 User Manual   02359 

Imagestore 3 User Manual   02954 

Imagestore HDTV User Manual  02901 

MDS User manual   01184 

Textbuilder User Manual   02735 

Textbuilder 2 User Manual  02960 

Intuition User Manual   03457 

Intuition Builder User Manual  03454 

Imagestore Media Manager User Manual  03332 
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Contacts 

 

For technical assistance, please contact your nearest Miranda Technical 

Support centre: 

 

Americas 

Telephone:  +1-800-224-7882 

techsupp@miranda.com 

 

Asia 

Telephone:  +81-3-5730-2987 

asiatech@miranda.com  

 

Europe, Middle East, Africa, UK 

Telephone: +44 (0) 1491 820222 

eurotech@miranda.com 

 

France (only) 

Telephone: +33 (0) 1 55 86 87 88 

francetech@miranda.com 

 

 

www.miranda.com 
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Conventions used in this user guide 

The following typestyle conventions are used throughout this user manual: 

♦ boldface is used for emphasis and button names 

♦ italics are used for screen titles, references to other parts of the guide and 

new terms 
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Overview 

Media Conversion Software (MCS) is a suite of programs which support 

Miranda Technologies Ltd.’s range of professional broadcast products. This 

range includes Imagestore, Playstore, Logostore and Intuition. For the 

purposes of this document, the term Imagestore will be used to refer to any 

products in the range, which are able to playout animations and stills. 

The conversions and functions which each MCS tool can perform are listed 

below. 

Animation Builder 

The Animation Builder is used to produce both still images and animations 

for use with Imagestore units. Still images can be imported from several 

different file types and numbered sequences of images can be used to form 

animations. Image parameters such as position, title and keying modes can all 

be viewed and edited. When importing animations, the program can 

automatically crop images to their associated key and de-interleave field-

based images, to produce the highest quality animations using the smallest 

amount of Imagestore playout memory. 

Animation Builder can read the following types of files: 

Standard image formats (.BMP, .TGA, .GIF, .TIF, .JPG, .PNG) 

Adobe Photoshop file (.PSD) 

Quantel VPB images (.VPB) 

Miranda Technologies Ltd. OXT still image format (.OXT) 

Miranda Technologies Ltd. OXA YUV animated image format (.OXA) 

Miranda Technologies Ltd. OXI RGB animated image format (.OXI) 

 

Animation Builder outputs the following kinds of files: 

Miranda Technologies Ltd. OXT still image format (.OXT) 

Miranda Technologies Ltd. OXA YUV animated image format (.OXA) 

Miranda Technologies Ltd. OXI RGB animated image format (.OXI)  
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Also, images can be copied to the windows clipboard, allowing them to be 

pasted into any other windows program. 

Animation sequences can be built from a series of sequentially numbered 

images in any of the above formats. For importing animations from graphics 

workstations, formats which include key/alpha channel information (eg 

Targa, TIFF, etc.), are the preferred format. 

Clock Builder 

For units with the Bugclock in-vision clock option, digital and analogue clock 

designs can be constructed from still images for each of the clock 

components. All still image formats supported by Animation Builder are also 

supported by Clock Builder. Various parameters associated with the clock 

can be set using the program. A preview allows immediate testing of the 

clock being generated. Clock files generated by Clock Builder use Miranda 

Technologies Ltd. OXA format. 

Audio Builder 2 

WAV files can be converted to Miranda Technologies Ltd. audio files 

(.OXW) and (.OXE) for use with Easysound/Playsound systems. WAV, 

OXW and OXE files can also be played on the PC’s audio system. Properties 

of OXW and OXE audio files such as looping control can also be examined 

and adjusted. 

Batch converter 

The Batch Image Converter software is a utility to convert industry standard 

graphical file formats into Miranda Technologies Ltd. .OXT files. 

The supported formats are: 

1. Standard image formats (.BMP, .TGA, .GIF, .TIF, .JPG, .PNG) 

2. Adobe Photoshop file (.PSD) 

3. Quantel VPB images (.VPB) 

4. Miranda Technologies Ltd. OXT still image format (.OXT) 
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A further option to resize the image to a user-defined size is also available. 

This option can also be used to resize existing .OXT files. 

Clip Builder 

Clip Builder is a utility to transfer MPEG video clips to Clip-on and to create 

the Imagestore .clp reference thumbnail file. 

DVE Editor 

The DVE Editor is used to control the playout of the Imagestore DVE 

options. Animated DVE sequences can be defined and edited. 

 

PC Requirements 

The MCS tools runs on a PC workstation using MS Windows 95, 98, XP, 

2000 or Windows NT 4.0 operating systems. To use MCS, Miranda 

Technologies Ltd. recommends a minimum specification of a Pentium 

200MMX with 64Mb of RAM. 
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Installation 

To install the software place the compact disc into the CD drive of a 

networked computer. 

 

A html menu screen will automatically load (index.html) giving options to 

install software and/or view on-line documentation. 

 

To install the Media Conversion Software click on the Install hyperlink. 
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Click the Open button to continue.  

 

Follow the on-screen commands to launch the Install Shield Wizard. 
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When prompted, add your Name and Company details. 

 

 

 

Click Next to continue or Cancel to abort or Back to return to the previous 

command. 

 

Continue to follow the on-screen commands until the Media Conversion 

Software is installed. 

 

To run an application, open the Miranda MCS menu under the Start, 

Programs menu and select a program icon. 
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Uninstall 

To remove the Media Conversion Software from your PC click on Start, 

Settings, Control Panel. Double click on the Add/Remove Programs icon. 

 

 

 

Select Miranda Media Conversion Software then click on the Add/Remove 

button. 

 

The Uninstall wizard will now remove the software from your PC. 
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Click OK to continue. 
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Animation Builder 

The Animation Builder is the tool used for viewing, converting and 

modifying both still images and animations for use with Imagestore product 

range including Imagestore HDTV and Intuition. A variety of file formats 

can be imported and sequences of numbered images can be assembled into an 

animation. Keying parameters and other information (such as image titles) 

can be set up and the resulting files can be transferred (via the Ethernet or 

floppy disk) directly into the Imagestore units. 

Preparing Image Files for Animations 

The best animation results will always be obtained using images with 

separate keys. The most appropriate file formats to use for still images are the 

32-bit formats such as Targa and TIFF, which can typically be generated by 

most 3D animation and paint packages. These files hold RGB channel 

information and also the Alpha channel information that is essential for 

broadcast-quality keying. Many 3-D graphics systems and painting tools such 

as Cinema 4D, Adobe Photoshop
TM

 and Paintshop Pro
TM

 can produce files in 

the formats described. A number of file conversion utilities are readily 

available which you can use to convert other image files to the required 

format. 

Animation Builder uses the files extension to determine the file type. For 

example: 

♦ .TGA (Targa image files) 

♦ .BMP (Windows bitmap image files) 

♦ .OXT (Miranda Technologies Ltd. still images files) 

♦ .OXA (Miranda Technologies Ltd. YUV Animation/Clock files) 

♦ .OXI (Miranda Technologies Ltd. RGB Animations) 

♦ .VPB (Quantel video paint box image files) 

The files must be named sequentially, using a series of frame numbers as the 

ending characters. For example: 

my_anim_0001.tga, my_anim_0002.tga etc. 
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Most numbering formats with or without leading zeroes are supported. 

No aspect ratio conversion or resizing is performed on the incoming files 

(one input pixel maps to a single pixel in the resulting animation). Therefore 

the images should be rendered at the appropriate size and pixel aspect ratio 

for broadcast video: 

♦ 720 x 576 PAL 

♦ 720 x 486 NTSC. 

♦ 1920 x 1080 HD 

♦ 1280 x 720 HD  

Images smaller than full frame can of course be processed. 

 

Windows .BMP files, Quantel VPB files and JPEG files can also all be 

imported for animation sequences, but they do not support a separate key 

channel. If key channel data is contained in a separate series of images, this 

series of images can be imported as key images as a later step. 

Fields vs. Frames 

PAL Television runs at 25 frames per second and NTSC at 30 frames per 

second and each frame consists of two separate fields. It is important to 

remember when making images for animations that each field, 1 and 2, are 

offset from each other by both Y position (1 line) and time (1/50
th

 of a 

second, for PAL). Animation Builder works internally in fields and emulates 

the interlacing of the TV by adjusting the position of each field as it is 

displayed. 

Animation Builder supports two ways of importing images to allow smooth, 

high-quality animations to be produced. Suppose we wish to produce a one-

second, full-frame PAL animation of a moving object. When this is 

broadcast, we need to display 50 distinct fields. 

We could render 50 images at 720x576 resolution (each image file will be 

used to form a single field of the animation). As each image is input, half of 

the lines must be thrown away to produce fields. To tell Animation Builder to 

do this, choose Import Animation Images as Fields in the Preferences 

dialog. This works quite well, but the rendering of the animation will take 

twice as long as is required, because of the redundant data being produced. 
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The second approach is to render 25 frames at 720x576, with each frame 

containing valid data interleaved for both fields. If one of these images is 

loaded and viewed as a still, you will typically see tearing artefacts on the 

edges of horizontally moving objects, due to the interleaving. As Animation 

Builder reads these files, it splits the frame image into two separate field 

images. The interlace emulation of Animation Builder allows both options to 

be previewed and the correct one selected without transferring the animation 

to an Imagestore. 

Animation Duration 

Imagestore Intuition 

Because Intuitions read animations directly from the disk during playout, the 

duration of an animation is constrained only by the disk space available on 

the Intuition system. Using the Animation Builder’s optional cropping feature 

is recommended to reduce the size of the animation files. 

Other Imagestore systems 

The maximum duration of an animated sequence is not determined by the 

Animation Builder but by the video memory of the Imagestore used for 

playout. The basic video memory for Imagestore is 2 x 32Mb. – 32Mb for 

Preview and 32Mb for Programme (or foreground and midground, in cascade 

mode). 32 Megabytes gives roughly 20 full frames of PAL video (around 

0.75 seconds). Animations that use less than the full screen area can have 

proportionately more frames. An animation of around 1/64
th

 (or 1/8
th

 by 1/8
th)

 

of full screen could have a maximum duration of around 48 seconds.  

Video memory upgrade options for Imagestore can extend the video memory 

to 2 x 64Mb, 2 x 256Mb and 2 x 512Mb (HDTV), increasing the maximum 

animation duration accordingly. 

Imagestore units can loop animations to allow them to run continuously. In 

this case, the video memory needs to hold a single loop of the animation. 

Animation Builder can optionally use selective cropping to crop each frame 

independently to reduce the playout memory requirements. 
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Because of this and the dynamic nature of the packing algorithms used within 

the Imagestore, it’s not always possible to confirm that an animation will fit 

into the video memory before loading it on the Imagestore. The Animation 

Information display provides an estimate as to how much video memory will 

be required in the Imagestore. If an animation is loaded onto an Imagestore 

which is longer than the Imagestore allows, the animation will simply be 

truncated. 
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Starting the program 

Double click on the Animation Builder icon or use the  

Start, Programs, Miranda MCS option. 

 

The main screen will now be displayed. 
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Building Animations 

Before loading a sequence of image files into the Animation Builder, check 

that the preferences have been correctly set up for loading images as fields or 

frames. See Preferences in the Animation Builder Menus section for more 

information. 

Loading Sequence Files 

Select Open from the File menu and navigate the PC to locate any one of the 

series of sequence image files.  

 

 

 

Double clicking on any file within the sequence will bring up a prompt 

similar to that below. Select Yes to initiate file loading. 
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Note:  Sequence files must be located in the same directory and must share 

the same prefix. 

 

As each frame is loaded it is displayed in the main window. The alpha 

channel of each frame can be used to crop the frame to the minimum area 

required. Areas where the alpha data is close to zero (black) are removed 

from the borders of the image leaving a smaller active picture area for each 

frame. This can be set from the Key Garbage level field on the Animation 

Builder Preferences screen (see Preferences in the Animation Builder Menus 

section below for further details). 

 

As well as selecting a single file from the file open window, it is possible to 

select several files at once to form a sequence. Press and hold down the Shift 

key or Ctrl key and then click on the appropriate files. Regardless of the 

order of your selection, the images will be loaded in sequence-number order. 

 

If a single still image file is selected (or the user selects No when asked if a 

sequence of files is to be loaded), the file is loaded as a still image. The 

Field/Frame loading modes have no effect for single still images, as they are 

always displayed and treated as frames. Still images can be then saved as 

.OXT files for use with Imagestores. 
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Loading Animation Files 

Previously created animation files may be reloaded for editing or viewing. 

These files will have either the file extension .OXA for YUV formatted 

animations, or .OXI for Intuition RGB animations.  

Viewing animations 

As each field is loaded, it is displayed in the main application window and, 

once loading is complete, the player controls take on a colour indicating that 

they are active. You use these movie-player controls at the bottom of the 

window to run the animation.  

 

 

 

From left to right the controls are: 

♦ Play the animation sequence. 

♦ Stop the animation sequence. 

♦ Index forward by 1 Field. 

♦ Index backward by 1 Field. 

 

The three buttons on the top bar allow you to view the image fill, the image 

key and the result of the keying over a matte colour. 

 

 

 

From left to right the controls are: 

♦ View fill. 

♦ View key 

♦ View result. 

♦ Display Bounding Box.   
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Appending Files 

With an animation sequence loaded, it is possible to append a further series 

of files to it. Select Append Frames from the File menu and locate any one 

of the series of image files to be appended. Double clicking on any file within 

the sequence will bring up a prompt similar to that above. Select Yes to 

initiate file loading. 

Saving an Animation 

Select Save as…  from the File menu and navigate the PC to locate the folder 

in which the animation is to be saved. Enter the file name for the animation at 

the prompt. If the animation is intended for playout on an Imagestore 

Intuition system, select the OXI format from the drop-down list. Otherwise, 

select the OXA format. The default format can be defined in the Preferences 

under the File menu. 

Building still images 

Animation Builder provides all the same facilities for still images including 

adjustment of keying parameters and viewing aspect ratio adjustments. Still 

images are saved in Miranda Technologies Ltd. proprietary OXT format.   

 

To load a Fill image select File then Open. Use the open dialog window to 

locate the graphics file then click on the Open button to load it. 

 

Refer to the Key menu section for details of loading key images. 

 

Note:  Imagestore Intuition systems provide direct support for loading a 

variety of the commonly used still file formats so conversion of stills 

to the OXT format is not necessary. 
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Animation Builder Menus 

This section describes the commands available in all the Animation Builder 

menus. 

File menu 

 

 

Open 

Allows you to open the following types of items. 

♦ existing Miranda Technologies Ltd. animations (.OXA and .OXI) 

♦ single frame still images in OXT and a variety of popular formats 

♦ multiple still images in the above formats to form an animation 
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Append Frames 

Allows you to append more frames to an existing animation sequence. All 

still image formats supported by Open are also supported by Append. 

Save 

Allows you to save the current animation to disk on the PC. If the animation 

does not yet have a valid name, you will be prompted for one.  

Save as 

Allows you to save the animation (as Save above) but with a different name 

or on a different disk or in another directory. 

Preferences 

When you choose Preferences from the File menu, the Animation Builder 

Preferences dialog box is displayed. Unlike the animation options, the 

settings in preferences affect the behaviour of the program for all animations 

and are automatically preserved between sessions in the Windows registry. 

The settings for the animation preferences are only applied when you click 

the OK button or press the Enter key. 



Animation Builder Media Conversion Software 

Page 38 Miranda Technologies Ltd 

 

 

Video Standard 

Select the appropriate Video Standard for which you are producing and 

viewing material. Amongst other things, this affects the viewing aspect ratio 

when viewing for formats other than square pixels – as described below. 

Field Rate 

Controls the playout rate for HD Standards.   

Import Animation Images as 

When you select Frames, the Animation Builder will create both fields that 

comprise a video frame from the single image. If you select Fields, the 

animation will take alternate fields from each successive image and discard 

the unused lines. See Fields vs. Frames in the Preparing Image Files for 

Animations section.. 
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Clip Frames on Loading 

When you select Clip frames on loading, Animation Builder discards all data 

outside a bounding box of active key pixels. This selection speeds the loading 

of files and reduces both PC and Imagestore memory usage substantially. 

When the option is not selected, Animation Builder loads the whole image 

irrespective of the key data. 

When you bring in images with noisy key signals, the Key Garbage level 

(default of 0) should be increased to allow correct key clipping. This is 

especially important when key images have come from outside the digital 

domain. Experiment with gradually increasing values for this until the frames 

are cropped correctly. (0 = black and 255 = white). 

Preview 

This section controls a variety of preview options that allow you to select 

how images and animations are viewed on the PC. These settings have no 

effect on the resulting image files. 

Selecting an Aspect of anything other than ‘Square’ causes aspect ratio 

correction to be applied to images viewed with Animation Builder, 

compensating for the difference in pixel aspect ratio between the target 

broadcast system and the PC. 

To change the background colour over which images are composited, click 

on the colour swatch next to the Compositing matte colour and select a new 

colour. 

Use the Safe zone controls to determine whether you wish the safe zones to 

be displayed and control their size and colour. Safe zones are shown 

whenever Animation Builder displays the full screen area ie when View 

Positioned is selected from the Edit menu, and when the Edit Position 

Graphically option is used from the Animation Options dialog. 

Default colour mode 

This option determines the colour mode of the animation.  For the Imagestore 

range of products select .OXA (YUV encoded) and for Intuition select .OXI 

(RGB encoded). 
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Animation size warning 

The preceding section Animation Duration described some of the limitations 

that are applicable to the maximum duration of animations that can be played 

out. This option can be used to define the maximum animation file size that 

can be saved. Saving animations larger than the given size produces a 

warning message. 
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Save to floppies 

For systems where transfer via Ethernet cannot be used, MCS provides a 

highly efficient means of transferring large animations and images via floppy 

disk. 

 

Note: All files should initially be saved to the hard disk as .OXA or .OXI 

files.  

 

A single animation can be saved onto a set of floppy disks, which can then be 

loaded into the Imagestore unit. An extremely effective lossless compression 

technique is used, which can substantially reduce the number of disks 

required to transfer large animations. The resulting disk set can be loaded 

into the Imagestore in any order, with the Imagestore automatically 

prompting for the next expected disk. Only the following product software 

releases support the compressed floppy disk format: 

 

Logostore all versions 

Playstore version 1.16 

Imagestore IS2 version 1.17 or later 

Imagestore Solo version 2.13 or later 

Imagestore 3 version 3.13 or later 

Imagestore HDTV version 1.02 

 

Note: Imagestore IS1 units cannot support the compressed floppy format. 

Network Transfer 

All MCS tools can directly transfer their output files to Imagestore units 

equipped with Miranda Technologies Ltd. Ethernet interfaces, connected via 

TCP/IP networking. For example, to transfer an image or animation, choose 

Network Transfer from the File menu. A dialog will be shown which allows 

you to select the destination Imagestore unit. 

The ‘pull-down’ list contains all units listed in the units.txt file, described in 

the section on configuring PC networking for Imagestores. You can transfer 
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to any other unit simply by typing in the units name (which must appear in 

the hosts file) or its IP address. 

 

Note: Logostore units cannot be fitted with Ethernet, so images and 

animations must be transferred via floppy disks. 

 

 

 

Although it is possible to cancel a transfer, which is already in progress using 

the Cancel button, you can only use this operation with Imagestore version 

1.17 or later. Earlier versions of Imagestore may crash and need to be 

rebooted. 

Print 

Prints the current image. 

1 2 3 4 

As with other windows applications the last 4 edited files are listed for ease 

of access. 

Exit 

Closes the Animation Builder program. If you have an unsaved animation or 

image, you will be prompted to save it before exiting. 
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Edit menu 

 

 

Cut 

This option is unavailable. 

Copy 

Copies the current animation frame or still image onto the Windows 

clipboard for pasting into other programs. The View Fill, View Key and 

View Result buttons determine how the image is copied.  

Paste 

This option is unavailable. 
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Animation Options 

When you choose Animation Options from the Edit menu the Animation 

Options dialog box is displayed. You can now set a variety of options relating 

to the loaded animation. 

 

 

Markers 

The thumbnail field allows any single frame of the animation to be 

nominated as the thumbnail frame. Imagestore or Media Distribution Systems 

may use this frame to create a still thumbnail image representing the 

animation. 

The Loop Start Field and Loop Stop Field enable you to specify the start and 

finish fields of an animation loop. These are only available for use if the In-

Loop-Out option is selected in Animation Style. 
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Loop mode 

There are six animation style options: 

♦ Cycle 

♦ Single Shot 

♦ In-Loop-Out 

♦ Linear Control 

♦ Ping-Pong 

♦ Multi-Loop 

 

To select an option, simply click in the check box next to the appropriate 

option. 

Cycle 

When you select Cycle and the animation is saved, an Imagestore will 

continuously repeat this animation sequence when it is taken on-air. When 

the animation is cut to air, it will begin cycling at the start point of the 

animation. 

Single Shot 

When you select Single Shot and the animation is saved, an Imagestore will 

playout the sequence once each time the animation is taken on-air. Once the 

animated sequence has run its course, the final frame remains on air as a still 

image until taken off-air. If the last frame of the animation is blank this will 

give the appearance of the animation disappearing. 

In-Loop-Out 

When you select In-Loop-Out, the Loop Start frame and Loop Stop frame 

options become available and are displayed in black. You can now specify 

the start and end frames for the loop. In this mode, when the animation is 

displayed the In section will be played through once. The defined Loop 

section will then be repeated continuously. When the command to take the 

animation off air is issued, the Out section is played out prior to the 

animation being taken off. 
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Linear Control 

When you select Linear Control and the animation is saved, an Imagestore 

will take the animation frame either from an automation system or use an 

analogue fader input to control the frame that is being displayed. This could 

be used in conjunction with an external fader, T-bar or control. 

Ping Pong 

When you select Ping-Pong and the animation is saved, an Imagestore will 

cycle the animation sequence forwards and backwards (i.e. when it reaches 

the end of the sequence it goes backwards through the sequence to the 

beginning again). 

Multi-Loop 

Selecting Multi-Loop allows you to add loops (delays) between any 

frame/field within the animation. This is especially useful for generating 

countdown or count-up timer applications. 
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The example shown above is a sequence of frames, converted to fields on 

loading. When the Multi-Loop option is selected the main screen displays the 

controls necessary to add loops. 

 

Insert Counters an all Frames 

If a loop is required between all frames, click on the appropriate insert 

button. 

 

 

 

Each individual field counter will now change colour depending on its status. 

Yellow = repeated field within a loop. 

Green  = Loop Start Field 

Red = active field 

 

 

 

The above screen shows the active field (1), which loops back to field 0, 25 

times, i.e. a 1 second delay (PAL). 

As the animation plays the red field counter will increment until it reaches 

the next green field where it will loop back according the parameters set. 
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Insert Loop 

Click on the field where the loop is to start (it will turn red) then press the 

Insert loop button. Use the options to select the Loop back to Field and the 

No of times to loop. 

  

Note: Only even fields can be included in a loop. 

 

Deletet Loop 

To delete a loop click on any field within the loop the press the Delete loop 

button. 

 

Note: Multi-Loop are only supported from IS2 v2.13 software onwards. 
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Position 

The vertical and horizontal position of the image on-screen is set by the 

values in the X position and Y position boxes respectively. The values are in 

pixels and are the distance from the top left corner of the image to the top left 

corner of the screen. The original position of a clipped image within its 

original frame is maintained.  

To position the image visually, click on the Edit Position Graphically button. 

 

 

Adjust the values until the desired position is obtained.  

Click OK to continue or Cancel to abort. 
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Various 

Play multi-loop once 

Used by Imagestore Intuition only. Without this option selected, multi-loop 

animations return to the start of the sequence once they finish playing out. 

With the option selected, the sequence is only played out once and the last 

frame is held as for single shot animations. 

 

Window Mode 

If the still image or animation is saved with Window Mode selected, the key 

image only is used by Imagestore to reveal the Fill input source. This option 

is not supported by Imagestore Intuition. 

 

Title 

The title for an animations and stills can be viewed and edited in this field. 

When using Imagestores with RCP-200 control panels, the image title can be 

viewed and used to help locate images within the database. 

Animation Info 

When you select Animation Info from the Edit menu, statistical information 

relating to the current animation loaded in the viewer is displayed. 
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The Video Frames data relating to an animation can be used as a guide to the 

memory requirements of the sequence when loaded in an Imagestore (32Mb 

of display equals around 20 video frames). 

View Positioned 

When this option is selected, the image is shown in its on-screen position, as 

set by the x-y co-ordinates. 

 

 

 

To return to centre screen image deselect the option. 
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Key menu 

 

 

These options are used for loading and adjusting the Key image, which can 

only be loaded after a Fill image. 

Load Key Images 

Select Load Key Images from the Key menu and navigate the PC to locate 

the key image file. When the key file has been loaded it may be viewed by 

clicking View Key icon. 

Adjust Key Params 

Select Adjust Key Params from the Key menu and the Key Adjustments 

window will appear. Drag the adjustment window to a position where the 

animation may be viewed whilst making adjustments. 

The main area of this window shows a histogram of key levels for the current 

frame. The key clip and gain values are represented by the red line on the 

animation luminance display. Clicking and dragging on the red line enables 

the slope to be modified (the lower half of the line affects the clip, while the 

upper half affects the gain). As with opacity, the effects of clip and gain level 

changes can be seen as the adjustment is made. Key polarity can be inverted 

or restored to normal by clicking against the appropriate option.  

As the Opacity adjustment is dragged up and down the effect will be clearly 

visible on the animation. 

The key source (separate key, luminance key or no key) and keying 

algorithm (additive or full) can also be selected from this menu.  
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Animation Builder Media Conversion Software 

Page 54 Miranda Technologies Ltd 

Key Polarity 

Normal white is keyed image/black is transparent 

Inverted black is keyed image/white is transparent (that is, 

inverse of normal) 

Key Source 

Separate Key uses image alpha/key channel (only available if 

image has key channel) 

Luminance Key uses image-luma signal to generate key 

No Key uses full screen of white as key (unless cropped) 

Keying Mode 

Full Key standard keying mode 

Linear Key used to overcome problems with keyed edges 

(especially when using self keying) 

CGT Numbers 

Clip range 0 – 1023 (default is 64) (anything below the 

displayed value is transparent) 

Gain range 0 – 1023 (default is 940) (anything above 

the displayed value is fully keyed on) 

Clip and gain values can be changed by dragging the line on the graph at the 

top of the screen. 

Transparency/Opacity 512 is completely opaque/0 is completely 

transparent 

The transparency/opacity of an image can be changed by moving/sliding the 

pointer in the Opacity box. 
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Crop Frames to Key 

Occasionally you may wish to load a series of images with cropping disabled 

via the preferences menu and subsequently crop them to their key. When you 

select the Crop Frames to Key option from the Key menu, the image is 

automatically cropped according to the key garbage level set on the 

Animation Builder Preferences screen. The Clip Frames on loading option 

in the Animation Builder Preferences screen must not be selected if you want 

to crop an image to its key after you have loaded it. 

Markers menu 

 

 

Mark Loop Start 

You use the Mark Loop Start command to indicate the start frame for an in-

loop-out animation. This command is only available if you have chosen In-

Loop-Out on the Animation Options screen. To specify the start of the loop, 

choose Mark Loop Start and then use the animation player controls at the 

bottom of the screen to mark the start position. 

Mark Loop End 

You use the Mark Loop End command to indicate the end frame for an in-

loop-out animation. This command is only available if you have chosen  In-

Loop-Out on the Animation Options screen  (see Loop mode above). To 

specify the start of the loop, choose Mark Loop End and then use the 

animation player controls at the bottom of the screen to mark the end 

position. 
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Mark Thumbnail 

The thumbnail frame is used by Miranda Technologies Ltd. Media 

Distribution System and Imagestore’s Polyphoto display to produce a 

thumbnail image representing the animation. The frame may be selected 

either from the Animation Options window opened from the Edit menu, or 

from the Markers menu. To select a frame from the Markers menu, use the 

animation viewer controls to step through the animation frames until the 

desired frame is displayed. Select Mark Thumbnail from Markers menu. 

The currently displayed frame will be set as the thumbnail frame. After 

Animation Builder loads an animation, it automatically positions the 

animation to the chosen frame. 

Help menu 

About 

Select About from the Help menu to display details about the software 

version of Animation Builder. This box also contains a link to Miranda 

Technologies Ltd. web site at www.miranda.com 

 

Command Line Options 

Animation Builder provides some command line options that can be used to 

create automated batch files that do not require user intervention. In order to 

use these options, you must either open the command prompt within the 

MCS tools directory or add the directory to your “PATH” environment 

variable. The default installation directory is “C:\Program Files\Miranda 

MCS”. The executable is called “anim_tester” and the following options are 

currently supported: 

 

For compatibility reasons, the first argument is not expected to provide an 

option code, but is expected to be the file path of either an animation, an 

EasyText template, a clock or the root of an image sequence. The root is the 

path of the sequence that excludes the numbered part and extension (eg pass 
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"C:\seq" to load "C:\seq0000.tif", etc). Note that if the path contains spaces, 

the whole path must be given in double quotes. 

 

Any additional options are expected to provide an option code and can be 

listed in any order. The square brackets indicate placeholders for command 

parameters and they should not be included in the command line. 

 

-o[Path] 

Save an animation to the given path and exit Animation Builder. Note that if 

the path contains spaces, the whole path must be given in double quotes. 

 

-t[IP] 

Transfer an animation to the given IP and exit Animation Builder. 

 

-x[N] 

Set animation's X coordinate to N. 

 

-y[N] 

Set animation's Y coordinate to N. 

 

-m[N] 

Set animation's loop mode to N. The modes are 0: loop, 1: single shot, 2: in-

loop-out, 3: linear control, 4: ping-pong, 5: multi-loop. 
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Clock Builder 

Clock Builder conforms to all the normal Windows conventions and so if you 

are already familiar with the MS Windows environment you will find it easy 

to use. 

File Formats 

For analogue clocks, images should be designed with square aspect ratio 

pixels. Conversion to destination aspect ratios is performed by the Bugclock 

system. 

For digital clocks, images should be produced with the appropriate pixel 

aspect ratio for the target video system. Bugclock performs no aspect ratio 

conversion on these images. 

As with Animation Builder, OXT, VPB and a variety of popular image 

formats are supported. However, as a key is essential for all clock 

components (except clock faces),  32-bit Targa or TIFF files are the most 

useful format for these items. 

General Principles 

Clocks are built from a series of components. For analogue clocks, these 

components are the clock face, hour hand, minute hand and an optional 

second hand. For digital clocks, the components are the clock face, each of 

the digits, 0-9 and a separator character – typically a colon and/or slash. 

Bugclock Limitations 

Currently, the Clock Builder can be used to create clocks, which are too large 

or complex for the Bugclock system to display correctly (this may cause 

problems with Imagestore). Please bear in mind the clock size limits 

described in the Bugclock specification. Future versions of Clock Builder 

will include built-in checking to prevent users exceeding these limits. 
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Starting the program 

Double click on the Clock Builder icon or use the  

Start, Programs Miranda MCS option. 

 

The main screen will now be displayed. 
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Beneath the standard menu titles there a variety of icons which enable you to:  

 

♦ create a new clock 

♦ open an existing clock 

♦ save the clock you are currently working on 

♦ transfer the clock to Imagestore over the network 

♦ get further information (help) about Clock Builder and/or visit the 

Miranda Technologies Ltd. web site 

♦ import (load) an image (component) 

♦ move to the next clock component (step forward through all the different 

components of your clock) 

♦ change the component you are currently working with (click on the 

down arrow and choose a different component from the drop-down list) 

♦ move to the previous clock component (step backwards through all the 

different components of your clock) 

♦ look at (preview) your clock 

At the right of the window you will see details about: 

 

♦ the width and height of the component (this is for information only). 

♦ the Time Position (the reference point controls allow you to move the 

reference point of the components around)  

The component you are currently working on is displayed in the main area of 

the window. 

The name of the clock you are currently working on is displayed in the title 

window at the top of the screen.  
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Clock Builder menus 

File Menu 

 

 

New 

Selecting File then New will open the Create New Clock window. Click on 

the required type then click OK to continue or Cancel to abort. 
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Open 

Allows you to open an existing Analog or Digital clock saved in Miranda 

Technologies Ltd. OXA file format. To load a clock select file then Open. 

Use the Open clock file window to locate the graphics file then click on the 

Open button to load it. 

 

Save 

File Save will re-save the clock you have opened, with any changes made. If 

no changes have been made the option will be greyed out.  

 

Save as 

File Save as will allow you to save the clock you have opened, with or 

without any changes made to a different location and file name. Use the Save 

as window to locate a directory, adjust the name if necessary then click on 

the Save button to save it. 

 

Save to floppies 

For systems where transfer via Ethernet cannot be used, MCS provides a 

highly efficient means of transferring clock via floppy disk. 

Note: All files should initially be saved to the hard disk as .OXA files.  

Clock images can be saved onto a set of floppy disks, which can then be 

loaded into the Imagestore unit. An extremely effective lossless compression 

technique is used, which can substantially reduce the number of disks 

required to transfer many images. The resulting disk set can be loaded into 

the Imagestore in any order, with the Imagestore automatically prompting for 

the next expected disk.  
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Only the following product software releases support the compressed floppy 

disk format: 

 

Logostore all versions 

Playstore version 1.16 

Imagestore IS2 version 1.17 or later 

Imagestore Solo version 2.13 or later 

Imagestore 3 version 3.13 or later 

 

Note: Imagagestore IS1 units cannot support the compressed floppy 

format. 

Network Transfer 

All MCS tools can directly transfer their output files to Imagestore units 

equipped with Miranda Technologies Ltd. Ethernet interfaces, connected via 

TCP/IP networking. For example, to transfer a clock select File then 

Network Transfer. A dialog will be shown which allows you to select the 

destination Imagestore unit. 

The ‘pull-down’ list contains all units listed in the units.txt file, described in 

the section on configuring PC networking for Imagestores. You can transfer 

to any other unit simply by typing in the units name (which must appear in 

the hosts file) or it’s IP address 

Note: Logostore units cannot be fitted with Ethernet, so clocks must 

be transferred via floppy disks. 
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Although it is possible to cancel a transfer which is already in progress using 

the Cancel button, you can only use this operation with Imagestore version 

1.17 or later. Earlier versions of Imagestore may crash and need to be 

rebooted. 

 

Import Component Image 

Clocks are constructed from a series of components: face, hour hand, minute 

hand, second hand, and for digital clocks numbers 0-9 and a time and date 

separator. 

 

To import a component select File then Import Component Image. Use the 

Import image file for window to locate the graphics file. The type of 

component being imported is determined by the entry in the component drop 

down box, located in the main screen. 

 

 

 

Select each entry in tern then import the image. 

Note: Miranda Technologies Ltd. recommends that the face graphic is a 

32-bit Targa file with RGB and Fill. 

 

Load Series of Components 

If you want to load a series of components for your clock (for example, the 

face, hour hand, minute hand, second hand etc.), choose Load Series of 
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Components from the File menu and then select each image as described 

above. 

Exit 

Closes the Clock Builder program. If you have an unsaved image, you will be 

prompted to save it before exiting. 

 

 

Edit menu 

 

 

Cut 

This option is unavailable. 

Copy 

This option is unavailable. 

Paste 

This option is unavailable. 
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Remove Component 

Removes the displayed component from the clock structure. 

Using Next, Previous or selecting from the component drop down box 

displays the component in the main screen. Select Edit then Remove 

Component to delete the graphic. 

 

Digital Clock Options 

This option is only available when constructing a digital clock. 

 

To display the Digital clock options window select Edit then Digital Clock 

Options. 

 

A large number of digital clock formats are available. For example: 

♦ 12 and 24-hour formats 

♦ formats with and without seconds displays 

♦ several date and time/date formats 

♦ different separtor images for time and date (for example, 12/12/00 

12:00:45) 

♦ time and date strings displayed in separate positions on the clock face 

♦ separate time and date strings which can be left-, right- or centre-

aligned (to allow a fixed reference position on the clock face) 

♦ no time or no date format 

♦ a large range of date formats (for example, four-digit year) 

 

Click in the radio boxes next to the required options then click OK to 

continue or Cancel to abort. 
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Clock Options… 

This option is available for both Analog and Digital clocks. 

To display the Clock Options window select Edit then Clock Options. 
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From the Clock Options window you can: 

♦ select a clock type. 

♦ position the clock using x and y coordinates. 

♦ adjust the key parameters, clip, gain and transparency levels. 

♦ change the key source (separate, self or none) 

♦ change the key type (full or linear) 

♦ change the key invert (normal or inverted) 

♦ change the timing modes (timer rate, timer start time, countdown to and 

offset) 

Clock Types 

Time-of-Day 

Time-of-day clocks are conventional clocks which show the current time-of-

day. In Bugclock systems, this is derived either from an incoming LTC or 

VITC timecode feed or from the Imagestores internal battery-backed clock. 

Timer 

Timers are time displays typically controlled from GPI trigger signals. Timer 

clocks can have rate and duration (Timer Start Time) set in Clock Builder. 

The rate is positive for count-up timers and negative for count-down timers. 

Rates can go from 1% to 200% to allow for clocks which count at non-

realtime rates. GPI triggers can be used to stop, start and reset timers. 

Time-of-day countdowns 

Time-of-day countdowns are typically used to display time remaining until a 

particular event. They could, for example, be used to show hours, minutes 

and seconds until a particular event or the number of days to Christmas. In 

the Timing Modes section select the date (Countdown to) and time. 
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Clock Position 

X Position 

Sets the on screen x coordinate 

Y Position 

Sets the on screen y coordinate 

 

Key Parameters 

Key Invert 

Normal white is keyed image/black is transparent 

Inverted black is keyed image/white is transparent (that is, 

inverse of normal) 

Key Source 

Separate uses image alpha/key channel (only available if 

image has key channel) 

Self  uses iamage-luma signal to generate key 

None uses full screen of white as key (unless cropped) 

Keying Type 

Full  standard keying mode 

Linear  used to overcome problems with keyed edges 

(especially when using self keying) 

CTG 

Clip range 0 – 1023 (default is 63) (anything below the 

displayed value is transparent) 

Gain range 0 – 1023 (default is 1023) (anything above 

the displayed value is fully keyed on) 

Transparency 512 is completely opaque/0 is completely 

transparent 
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Timing modes 

Timer Rate (%) 

Set a positive rate for count-up timers and a negative rate for count-down 

timers. Rates can go from 1% to 200% to allow for clocks which count at 

non-realtime rates. 100% = realtime. 

Timer Start Time 

Sets the duration of the timer. To adjust the time, click the mouse on a pair of 

digits and either type in a value or use the up and down arrows. 

A 30 minute timer would be 00:30:00. 

Countdown to: 

Sets a target date and time for the countdown the timer. To adjust the date, 

click the mouse on a pair of digits and either type in a value or use the arrow 

to the right of the field. This will open a calendar window. 

 

To adjust the time, click the mouse on a pair of digits and either type in a 

value or use the up and down arrows. 

 

This feature is useful for counting down the New Year or other memorable 

events. 

Offset 

Offset time for the clock. Useful for inserting delays or dealing with different 

time zones. 
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View menu 

 

 

 

View Key 

Shows the key image of the displayed component. 

 

Preview 

Previews the clock taking account of the x-y position and clock option 

settings. 

 

Help menu 

About 

Select About from the Help menu to display details about the software 

version of Clock Builder. This box also contains a link to Miranda 

Technologies Ltd. web site at www.miranda.com 
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Building an Analogue clock 

Once you have imported an analogue clock face you must set the reference 

point. The reference point is the point about which the clock hands rotate and 

would normally be the centre of the image. You can set the reference point 

by: 

♦ entering numbers in the X and Y centre boxes in the right-hand pane. As 

you enter numbers or adjust them with the arrows a crosshair will be 

shown on the face. 

♦ dragging the cross hairs into the correct position. Point at the appropriate 

line (cross hair), press and hold down the left mouse button, drag the line 

to its new position using the mouse and then release the mouse button. 
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You can now import the remaining components, hour hand, minute hand and 

an optional second hand. Set the reference point for each component. The 

reference points for the clock hands should be the point about which the 

hands rotate.  

 

Note The clock hands must be drawn in a 12:00:00 (vertical) position 

and they must have an associated Key layer . 

 

You can view the key of a component by choosing View Key from the View 

menu. The image will be transparent where the key is shown as black and 

opaque where it is shown as white. Anti-aliased soft keys with many shades 

of grey are essential for broadcast-quality images. 

 

At any point the clock can be previewed to check the effect of the keying and 

alignment. The previewed clock is shown, as it would appear over a white 

background. For example: 
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Building a Digital Clock 

Digital clocks are constructed in a similar way to analogue clocks, but instead 

of hands, the additional components are the digits, 0 - 9 and a separator. 

When a digital clock is selected, an extra box becomes visible on the main 

screen showing the digit and time separator widths. 

 

 

 

The reference points for each digit should typically be set to the bottom left 

of the digit. The crosshairs adapt with digital clocks to show the character 

width as well. 

The reference point for the face of a digital clock determines where the digits 

are aligned. With left alignment the reference point of the first digit will be 

aligned to the reference point of the clock face. 
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Special-purpose formats useful for timers and countdown clocks include an 

MM:SS format and Seconds and Days only. 

 

The alignment options determines how the clock digits are drawn relative to 

the reference point on the clock face. 

Separate date format options (see above) are only supported on the following 

Imagestore versions: 

♦ IS2V1 versions 1.20 and above 

♦ IS2V2 versions 2.08 and above 

If you select a date format for your clock (see the Digital Clock Options), a 

Date Position box is subsequently displayed on the main screen. 

 

 

Alternate Faces 

For digital clocks only, an extra component, the Alternate Face is available. 

If an image is imported for this component, then the Face component is used 

for even-numbered seconds and the Alternate Face for odd-numbered 

seconds. This allows clocks with flashing colons, or other similar features to 

be produced. 
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Previewing Clocks 

You can display a live preview of the clock you are currently building by: 

♦ clicking on the Preview Clock button 

♦ choosing Preview from the View menu 

Digital and analogue clocks will be previewed fully functioning, showing 

correct time and display formats, etc. The required video mode can be 

selected from the options at the bottom of the window. You can also change 

the colour of the background to the clock by clicking on the Colour button.  

 

Note that because the preview is automatically sized to fit the window, the 

resolution of the preview may be either higher or lower than actual playout. 
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Audio Builder 2 

The Miranda Technologies Ltd. Audio Builder 2 software is a MS Windows  

XP and 2000 compatible program, which allows the user to load, modify and 

save Miranda Technologies Ltd. audio format wave files.  

 

Once converted to the Miranda Technologies Ltd. audio format, files can be 

saved to floppy disk or transferred via a network to a Miranda Technologies 

Ltd. Imagestore fitted with Easyplay or a Playstore fitted with Playsound. 

 

There are two types of audio file which are used on the two different 

generations of Imagestore. OXW files are 2 channel audio files which work 

on the Imagestore 2/3 range fitted with Easyplay. OXE files are multi-

channel (up to 8) audio files which work on the Imagestore 300/Imagestore 

HDTV range fitted with Easyplay. 

 

Audio Builder 2 was produced to work seamlessly with both OXW files and 

OXE files.  

Audio Builder Functions 

1. New streaming architecture allows for very long audio clips to be created 

and played back (up to 7.1 channels). 

2. Load .OXW and OXE format audio files 

3. Load a wide range of compatible .wav and multi-channel .wav files  

4. Save .OXW and .OXE format audio files.  

5. Drag and Drop files from outside the application.  

6. Save multi-channel .wav format audio files.   

7. Modify loop property of .OXW and .OXE Format  

8. Play and rewind audio files  

9. View the properties of current audio setup. 
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10. Send Miranda Technologies Ltd. audio files over a network to an 

Miranda Technologies Ltd. Imagestore or Miranda Technologies Ltd. 

Playstore  

11. Compress Miranda Technologies Ltd. audio files to floppy disks (OXW 

files only) 

Audio Builder 2 file formats 

 

      Files it will Import            Files it will Export 

The native internal format is 32-bit 48kHz audio. If a .wav file is loaded 

which does not have a sample rate of 48kHz, the software will attempt to 

convert it using built in Windows Audio Codec’s.  Please note that the 

software will not attempt to convert multi-channel wave files.  

Internal format 

32-bit @ 48kHz 

 

 

1 to 8 Channels 

Playback 

.OXW  

2 Channels 

.OXE  

8 Channels 

.WAV  

2 Channels 

.WAV  

Multi-Channel  

.OXW  

2 Channels 

.OXE  

8 Channels 

.WAV  

Multi-Channel 
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Starting the program 

Double click on the Audio Builder icon or use the  

Start, Programs, Miranda MCS option. 

 

The main screen will now be displayed. 
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Channel List 

 

 

 

♦ Load File 

♦ Delete  

♦ Move Up 

♦ Move Down 

 

The channel list is used to build up an audio file. A maximum of up to 8 

channels are allowed in the list. The .OXW file format only supports 2 

channels therefore a warning is given to the user if trying to export any more 

than 2 channels to an OXW file. The order in which the channels are laid out 

can be modified using the move up, move down and delete buttons. The order 

specifies the order in which the channels are presented to the Imagestore. 

 

The user can drag and drop files from outside the application into the 

Channel List as quick way of loading files.  

Tick a channel 

box to hear during 

playback 
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Properties 

The properties area shows the total duration of the current audio file. The 

duration is calculated as the maximum duration of the longest audio channel. 

The looping option is used for looping the audio clip on the Imagestore and 

during playout on the PC. 

 

 
 

Playback 

The Playback section allows you to playback selected channels.  

 

 

 

 

♦ Plays/Pause file (from current playout position) 

♦ Stops file (rewind) 

♦ Adjust Master Volume 

♦ Adjust Playout position 

The horizontal slide bar tracks the play-out position of the loaded file. When 

a file is loaded an adjustment of this bar enables the user to easily review 

parts of the audio file by dragging the bar to a desired position and pressing 

play.  
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The slide bar can also be reposition during playback, however due to 

buffering of the audio data it may take a few second to seek to that position in 

the file. Note that the playback position will only be modified when the 

mouse button is released.  

During playback channels can not be modified in any way. The user must 

pause or stop playback before attempting to modify the channel list. The 

program can not be exited during playback either.  

Windows Preview 

Each channel can be dynamically assigned to a speaker destination for 

previewing under Windows. The speaker assignment has no affect on how 

the file is played out on the Imagestore; it is purely for preview purposes. 

When selecting a channel for playback, a single speaker can not be used 

twice. For example if playing back a 4 channel file, each channel must be 

assigned to a unique speaker.  This means if you have 4 stereo channels, you 

will only be able to playout one stereo channel at a time.  In order to increase 

playback compatibility the playback bit depth is currently set to 16 bit. If a 

higher playback resolution is required please send a request to the support 

staff at Miranda.  

 



Media Conversion Software Audio Builder 2 

Miranda Technologies Ltd  Page 85 

File menu 

 

 

Open  

Brings up the File open dialog box. The Files of Type drop-down box can be 

used to view available files with the following filters: 
1. All audio files OXW, OXE and WAV.  

2. Imagestore 2/3 files OXW. 

3. Imagestore 300/HD files OXE 

4. all files  

Once a file has been selected, pressing Open will load it into Audio Builder. 

All .WAV file formats can be opened for playing. 

Save as 

Brings up the File save dialog box. This can be used to save the file in the 

desired format. Note that OXW’s are only capable of holding 2 channels. If 

saving to a .wav format regardless if the file is 2 channels or less, it will be 

saved as a multi-channel wav file. Some old software may not support the 
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multi-channel wav format, but applications such as the latest Windows Media 

Player will.  

Save to floppies 

Stores a compressed audio file to one or more 1.44MB 3 ½’ floppy disks.  

When selected, a dialog box will appear indicating the number of floppy 

disks required for the save. To initiate the save, click Start Copy. A second 

dialog will appear asking if the destination floppy disk is to be erased before 

the copy. Clicking OK will continue with the save. This function is only 

available when an .OXW file is loaded (see File Transfer below). Please note 

that the Imagestore 300/HD do not support loading of Easyplay files from 

Floppy disk.  

Network Transfer  

Allows the user to send audio files to remote Miranda Technologies Ltd. 

equipment which is configured on a network.  When selected, a dialog box 

will appear with a drop down box listing all the possible destinations for the 

file. This list is derived from the hosts and units text files (see File Transfer 

below).  Once a destination is selected, pressing OK will send the file. 

1 2 3 4 

As with other windows applications the last 4 edited files are listed for ease 

of access. 

Exit  

Exits the Audio Builder application, prompting the user to save any unsaved 

files. Note you can’t exit while the application is playing.  
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View menu 

 

 

Wave Forms 

The wave form view gives a graphical representation of the audio data of 

each channel. It can be used to check the data is not being ‘clipped’ which 

will cause distortion during playback. It can also be a good to check if there 

is any noise during silent passages. For viewing multi-channel files it will 

make the user aware of the timing and levels between the different channels.  

 

 

 

The graphical view is not designed to be a wave editing tool, however you 

can adjust the level of each channel. This means if one channel is louder than 

the other channels you can reduce it slightly. The adjustment menu is 

selected by right clicking on the channel you wish to modify. The 
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adjustments are done in percentages. You can either increase or decrease the 

level of the channel. When selecting the level adjustment, it is permanent, 

there is no undo operation.  

 

 

View Logfile (for Multi-Channel) 

The log view contains information and error messages when processing audio 

files. If Audio Builder has a problem performing an operation it will log it to 

the log view.  
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Settings menu 

Select Audio Device (Sound Card) 

Selecting this option displays the Device Selector window: 

 

 

 

Use this window to select which of your installed audio devices you wish to 

use for preview playout, and whether you wish to use the DirectX playout 

option. The latter is required if you are using one of the Creative Labs sound 

cards. 

Help menu 

About  

Shows the Audio Builder About box with a link to the Miranda Technologies 

Ltd. Home Page at www.miranda.com along with the version number. 



Audio Builder 2 Media Conversion Software 

Page 90 Miranda Technologies Ltd 

Compatibility Issues 

If the PC does not have a sound card with multiple outputs then sound card 

driver may down-mix to a stereo output. Normally when this happens the 

other channels are played back at a reduced volume (you may not be able to 

hear them). If you have two sound cards installed, the volume control will 

only alter the volume on first sound card it finds. If this is a problem it is 

recommend that you disable the sound card that you are not using.  

Previewing using Dolby Digital 

Some sound cards support encoding their multi-channel output to a Dolby 

digital signal. Below is screen shot of an NVIDIA sound card, which does 

not support Dolby Digital output (the option is greyed out).  

 

 

 

Multi-Channel Playback on Imagestore 300/HD 

How each channel gets mapped to groups within the embedded output or the 

AES outputs is down to the mix-file within the Imagestore. Audio Builder 

has no way of configuring the mix-file it just lays the channels out in a 

numbered list 1-8. Also the Meta data contained within the OXE file is 

unused by the Imagestore. 
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Batch converter 

The Batch Image Converter software is a utility to convert industry standard 

graphical file formats into Miranda Technologies Ltd. .OXT files. 

 

A further option to resize the image to a user-defined size is also available. 

This option can also be used to resize existing .OXT files. 

Starting the program 

Double click on the Batch Image Converter icon or use  

the Start, Programs, Miranda MCS option. 

 

The main screen will now be displayed. 
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Output Folders 

Before selecting files to convert check the entry in the Output Folder section 

of the main screen as this is where all converted files will be stored.  

 

 

 

Select Destination folder 

To change the output folder either: 

 

♦ click on Options then Select destination folder, or  

 

 

♦ click on the Browse button. 

 

 

The Select folder window will then be displayed. 
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Use the drop down box at the top of the screen to locate and select a different 

folder. 

 

Press OK to continue or Cancel to abort. 

 

Note: New folders cannot be created from this window. If you require a 

new folder generate it in Windows Explorer first. 

 

Destination same as source 

If you want the converted files to be stored with the original graphics select 

Options then Destination same as source. 
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This will automatically set the output folder to match the source. The Output 

Folder section of the main screen will be greyed out indication that this 

feature is selected. To turn the option off, de-select it from the Options 

window. 

 

Note: This option will only work providing the source folder is NOT 

write protected. For images supplied on CD’s copy them onto your 

PC first. 
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Converting Files 

Having selected an output folder the next stage is to select the files to 

convert. 

 

Opening files 

To select the files click on the Open files(s) to convert button. 

 

 

Use the Select files(s) to convert… window to locate and select the files. 

 

 

 

Select the image(s) to be converted then click Open to proceed or Cancel to 

Abort. 
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Processing Queue 

The selected images are added to the Processing Queue shown in the main 

screen and file conversion will begin automatically.  

 

 

 

Each file is identified by its source location and filename (input) and 

destination location and converted filename (output). 
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Currently Processing 

The file at the top of the processing queue is also listed in the Currently 

Processing section along with a progress bar. When the progress bar reaches 

the right hand edge of the box the file conversion is complete and the entry is 

removed from the list. The Files Remaining counter will count down as the 

files are processed. 

 

 

Error Log 

In the event of errors being detected whilst converting a file, a description of 

the fault will be listed in the Error Log section and the conversion will not 

complete successfully.  

 

 

 

Identify and fix the error before converting the file. 
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Image Preview 

To preview a file whilst converting, select Options then select Display 

Preview Window. 

 

 

 

The preview section will now appear at the bottom of the main screen. 

 

 

 

View Mode 

Files can be previewed as image or key. The key image can only be viewed 

providing the file has one. 
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Global Image Manipulation 

The default images size for file conversion is 720 x 576 pixels, which is the 

default size for PAL broadcast. If your broadcast standard is different you 

will need to set the pixel size to the following: 

 

Format Width Height 

PAL 720 576 

NTSC 720 486 

HD 1280 720 

HD 1920 1080 

 

Click in the Resize All Images check box then type in the new pixel values 

before converting the files. 
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Clip Builder 

Clip Builder is a software package supplied on the MCS CD to:  

♦ enable transfer of MPEG video clips to Clip-on 

♦ create the Imagestore .clp reference thumbnail file  

 

 

 

Open MPEG Clip 

Click on the Open MPEG Clip button to locate the MPEG file on either 

your local drive or elsewhere on the network. Once loaded the file details will 

be listed below the thumbnail image. These include file name, resolution and 

number of frames. 
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Load Thumbnail 

To associate a thumbnail image with the loaded MPEG clip, click on the 

Load Thumbnail button. Use the Open window to locate a .bmp on either 

your local drive or elsewhere on the network. A preview of the selected 

bitmap will be shown in the preview panel. The thumbnail image is useful for 

identifying MPEG clips and will be displayed on the Presmaster 100 

touchscreen and in Polyphoto mode. If no bitmap is associated the system 

will use the default cine camera icon as on the previous page. 

End Mode 

Click on one of the following to select the appropriate End Mode: 

Loop 

Constantly repeats the clip. 

Freeze Frame 

Stops the clip on the last frame. 

Cut Keyer Down 

Cuts the keyer down when the clip finishes. 

Fade Keyer Down 

Fades the keyer down when the clip finishes. 

Call Next Clip 

Use this option start another clip when the current one finishes. 

 

To view the clips held on the Imagestore click on the browse button  
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Black 

Ends the clip with a black frame. 

Voice Over 

Do Not Use Voice Over 

Use this option if the clip has no associated audio or you do not wish to hear 

it. 

Use Voice Over 

Use this option if the clip has associated audio you wish to hear. 

Transfer 

Before transferring a file, make sure the target machines are selected and the 

IP addresses are correctly set. 

To enter the IP addresses click on Edit then IP Addresses from the menu 

bar. 

 

 

Enter the details of the units then click OK to continue or Cancel to abort. 
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To transfer both the MPEG clip and the thumbnail image click on the 

Transfer button. 

To abort the transfer, click on the Abort Transfer button. 
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DVE Editor 

The DVE Editor provides the tools to create and control the playout of DVE 

sequences. The editor connects to the Imagestore via the network and uses 

automation commands to control it. The automation commands are available 

on request if the user wishes to implement their own software control panel 

for it. In order to run the software you will need a networked Windows PC 

and of course an Imagestore with appropriate hardware and software.  

Connecting to the Imagestore  

To connect to the Imagestore you will need to type in the IP address of the 

Imagestore, and click Connect to Imagestore. The editor will remember the 

IP address of the Imagestore so you will not have to re-type it in next time 

you start the application.  

 

 

 

The Connect button changes colour to indicate the current connection state: 

 Red – Not connected to an Imagestore 

 Yellow – Attempting a connection 

 Green – Connected to an Imagestore 

 

Click to make the connection  
You can find the IP address of the 

Imagestore by looking under the 

‘Set-up->System Information’ 

option on the front panel of the 

Imagestore.  
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DVE Modes 

Imagestores can be operated in several different modes which affect how the 

video is routed through the system. An appropriate mode must be selected in 

order for the DVE to be visible on the output. The modes can either be set 

from the editor or from the Imagestore’s front panel. For details of using the 

front panel, please refer to your Imagestore manual. To set the mode from the 

editor, press the DVE Mode button. This will bring up the mode options that 

are appropriate to the Imagestore model you have connected to. 

Imagestore 2 / 300 DVE Modes 

In order for the DVE to operate, the Imagestore has to be in Cascade mode 

and not the Swap-Preview mode. You can check what mode it is in by using 

the front panel and going to ‘Setup -> System Setup -> Cascade/Swap-Pvw’. 

It should display ‘Cascade’. If it is not in Cascade mode, the DVE options 

will not operate or appear on the front panel menu. 

DVE Bypass  

 
 

The DVE is not enabled and no delays are added to either video or audio. 

 

DVE None 

 

 

Although the DVE is not enabled, both video and audio are delayed by one 

frame. 
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DVE(A + B) over DSK1 

 
 

The DVE uses the A and B inputs and is keyed over DSK1. On the front panel, this 

mode is “A B over DSK1”. 

 

DVE(ABMix + B) over DSK1 

 

 

The DVE operates on AB mix and the B input and is mixed over DSK1. On 

the front panel, this mode is “AB Mix B over DSK1”. 
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DVE(A + B) into DSK1 

 

The DVE operates on the A and B inputs and is keyed as DSK1. On the front 

panel, this mode is “DSK1: A B”. 

 

DVE(B + A) into DSK1 

 

The DVE operates on the B and A inputs and is keyed as DSK1. On the front 

panel, this mode is “DSK1: B A”. 
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DVE(A + DSK1) into DSK1 

 

The DVE operates on the A input and DSK1 fill and is keyed as DSK1. On 

the front panel, this mode is “DSK1: A DSK1”. 

 

DVE(DSK1 + A) into DSK1 

 

The DVE operates on DSK1 fill and the A input and is keyed as DSK1. On 

the front panel, this mode is “DSK1: DSK1 A”. 
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DVE(A + B) behind DSK1 

 

The DVE operates on the A and B inputs it replaces the AB Mixer. On the 

front panel, this mode is “Behind”. 
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Imagestore HD DVE Modes 

Imagestores HD currently provide 4 different modes. Over time more modes 

may get added so it is worth checking the Miranda website for Imagestore 

HD software updates.  

 

Bypass  

In Bypass mode no DVE circuitry is used and the video passes straight 

though the input router to the AB mixer.  

 

 
 

DVE None 

In this mode the DVE is in circuit but no video processing takes place. This 

mode simply delays the video and audio by one frame. The delay in this 

mode is exactly the same delay as for the DVE modes which perform video 

rescaling. The idea being that the modes which require video scaling can be 

switched to and from DVE None without the video/audio jumping by a 

frame.  
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DVE over DSK1 

In this mode both A and B video can be resized over the top of DSK1 Fill, 
from store or fill input. The processing delays the video and audio by one 

frame. Unlike the Imagestore 2/3, a separate audio processing board is not 

required to delay the embedded audio. This mode is ideal for having a dual 

squeeze back over an Easytext template or a full screen still.  

 

 
 

AB Mixer (A over B or B over A) 

The DVE replaces the AB Mixer. In this mode the DVE can resize the A and 

B video channels and place them on top of each other. The layering of the 

video is controlled via the DVE editor.  
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Imagestore 750 DVE Modes 

The IS750 has two separate DVEs, so as well as setting the appropriate DVE 

mode, it is important to select which of the DVEs the editor should control. 

The editor can control both simultaneously as well each one individually. Use 

the radio buttons at the top of the window to chose your required setting. 

 

 

 

The DVE mode is combination of two separate settings: 

 

Use the three highlighted boxes to switch between: 

• Bypass - the DVE is disabled and neither video 

nor audio are delayed. 

• None (Delay) - the DVE is disabled, but both 

video and audio are delayed by 1 frame. 

• Enabled - allows normal DVE processing. Video and audio are 

delayed by 1 frame. 
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When the DVE mode is set to Enabled, you can 

use the three highlighted boxes to control the 

layering of the DVE output with the DSKs. The 

leftmost option puts the DVE behind all four 

DSKs, the next option puts the DVE above DSK 

1, and the rightmost option puts the DVE above DSKs 1 & 2, but behind 3 & 

4. 

 

Sequences 

 

 

To load a sequence for editing, simply click one of the numbered buttons. To 

play a sequence backwards or forwards you can use the arrow buttons. The 

Imagestore 2 / 300 DVE option comes with 70 built in sequences. The 

Imagestore HD and 750 DVE comes with 20.  

 

Sequence 0 is reserved for playing a sequence backwards. For example you 

could set up a GPI to play sequence 72, then another GPI to recall sequence 0 

to play the sequence backwards.  
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What is a Sequence? 

The DVE presets represent timelined sequences of user defined keyframes. 

Each keyframe contains all the information for that particular frame e.g. size 

of video, position, border information, etc. The DVE interpolates (morphs) 

between the keyframes over a user defined number of frames. Another term 

for this is tweening, because the card calculates the ‘in-between’ frames. 

There is a limit of a total of 25 keyframes which are shared between both 

channels of video.  The following is an example of a 3 keyframe sequence 

which lasts over 7 seconds. 

 

 

Saving the Sequence 

Whilst working with a sequence, all your 

changes are saved in a ‘workspace’. If you 

load a new sequence or power off the unit, 

the workspace will be reset. Pressing either the play forward arrow or play 

backwards arrow plays the sequence stored in the current workspace. In order 

to commit the changes permanently you have to type in the desired sequence 

number and click the ‘Save as sequence no.’ button. 

Interpolate over 2 

seconds. 

 

Keyframe 1 Keyframe 2 Keyframe 3 

Interpolates over 5 

seconds. 
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Play Only Mode 

If you wish to use the editor purely to control the playout of 

sequences rather than editing them, then select the Play Only 

option. In this mode, clicking on a sequence number will immediately play 

the selected sequence. 

Note that if this option is turned off, selecting a sequence automatically 

displays the first keyframe, so enabling this option is the only way to ensure 

continuous playout of DVE sequences. 

 

Saving and Loading From Disk 

Using these options you can create 

sequences offline when you don’t have 

access to an Imagestore, and later load them when an Imagestore becomes 

available. You can create and edit sequence keyframes in the usual way (see 

sections on “Keyframe Control” and “Keyframe Editing”) and then use the 

Save to disk option to store it on your local hard drive or networked drive. If 

you then use the Load from disk option when connected to an Imagestore, 

the previously created sequence will be downloaded to the Imagestore and 

displayed for editing. 

 

These options are currently only available when using HD and 750 models of 

Imagestores. 
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Keyframe Control 

The Keyframes control panel gives you the ability to create, delete and save 

keyframes. After loading a sequence, the editor retrieves how many 

keyframes are in the current sequence and displays them. 

 

 

 

 

 

 

 

 

 

 

Thumbnails are currently only available when using HD and 750 models of 

Imagestores. 

Inserts a keyframe 

Sets the time it takes (in 

frames) to go between 

two keyframes 

Number of keyframes 

in the current sequence 

and the total duration 

Click these thumbnails to 

load a particular keyframe 

Used to link the playout 

of different sequences 

Deletes a keyframe 

Saves the current 

keyframe to a different 

keyframe 
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Keyframe Preview 

This option is currently only available when using HD and 750 models of 

Imagestores. 

 

On the right hand side of the editor is a preview window of the currently 

selected keyframe. Any changes to the keyframe will be reflected in the 

preview. In order to save the changes made you have to click the Save 

button. This will save the keyframe, but it won’t be permanently saved until 

the sequence itself is saved (using the Save as sequence button).  

 

 

The scaler is responsible 

for resizing the video.  

The mask is used to mask 

off the video. Usually the 

mask is linked with the 

scaler.  However it can be 

controlled independently 

for performing wipes.  

 Border position. 

This window shows the 

combined output from the 

mask and the scaler. Any 

part of the scaler outside 

the mask, will masked off.  
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Selecting a Channel 

When modifying various parameters such as video position/size you can 

specify which channel is affected.  

 

 

 

The ‘Reset Channel’ buttons will reset the video to full screen and use 

default settings for other DVE options. Note that if both channels are full 

screen then one will be placed on top of the other depending on the layering.  

 

Keyframe Editing 

The following panel allows you to position, rotate (not applicable to all 

configurations), crop, re-size, layer the video, etc. The available options will 

vary depending on the model of the Imagestore that your are using. You can 

drag the slider bars to adjust each parameter. For fine adjustment use the 

up/down arrow boxes or type in required values directly.  Reset option is also 

provided to restore each setting to its default value. 
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Imagestore 2 / 300 Panels 

The following options are available when using Imagestore 2 or Imagestore 

300 DVE options. 

Position 

You can position the video either along 3 axis. The following diagram should 

give you an idea of which direction the video will move when modifying the 

position. The best way to understand how it works it to use it in practice. 

 

  

 

 

At this limit the 

screen will be off to 

the right (if it started 

full screen). 
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Rotation 

The rotation panel work in the same manner as positioning. You adjust the 

sliders and the video will rotate in real time. The following screen grabs from 

the DVE show it rotating video around the three different axis.  

 
Rotating around the x-axis     Rotating around the y-axis    Rotating around the z-axis 

   
 

Pivot Points 

The following panel allows you to select a point over which the video is 

rotated around. The default for the pivot is the Center point. 
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Cropping 

You can crop the video 4 ways.  When the sliding bars are full extent, the 

video will be fully cropped in that direction. 

 

   
 

Aspect Ratio 

If you wish to adjust the aspect ratio of the video or the overall size use the 

following panel:  

 

   

 

An alternative to using this panel to adjust the size of the video is to position 

the video closer/further away on the z-axis.  
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Movement 

 
 

Selecting the various movement options will change how the current 

keyframe will be morphed from the previous keyframe. Experiment with the 

values until get the desired result.  

 

Border Size 

 

 

Use these options to enable the border effect and set its softness and 

symmetry. Symmetry controls how the softness is applied to the border. If the 

slider is at 0, the softness is applied to the outer edge. If the slider is at 

maximum, the softness is only applied to the inner edge. The softness is 

applied equally to both edges when the slider is in the middle. 
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Border Type 

 

 

The DVE option comes with a number of predefined border effects. Use this 

panel to go through them and select the required option. To see the effects of 

the different presets more clearly, ensure that you select three different 

colours for the border. You can adjust the colours later to fine tune the effect. 
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Border Colour 

 

 

Borders can use up to three individual colours to create the effect. The 

number of colours used depends on the type of border you have selected, so 

if you selected Single then only the first colour is used, but if you selected 

Triple then all three colours will be visible. The results of choosing different 

colours are best seeing through experimentation. You can either defined each 

colour using the given sliders, or you can select a colour using the standard 

Windows colour picker. 

 

Transparency 

 

 

To make the video transparent, use this panel to enable transparency and then 

use the slider to adjust it. 
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Layering 

Using the panel below you can change the order in which Channel 1 is 

displayed with reference to Channel 2.  

 

 
 
     Channel 1 on top       Intersecting                Channel 2 on top  

   
 

Defocus (Blur) 

 

 

Use this panel to enable the defocus effect. You can then use the sliders to 

adjust the amount of blur applied in the X & Y axis. 
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Mosaic 

 

 

Use this panel to enable the mosaic effect. You can then use the sliders to 

adjust the coarseness of the effect applied in the X & Y axis. 
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Imagestore HD / 750 Panels 

The following options are available when using Imagestore HD or 

Imagestore 750 DVE options. The DVE allows independent control of the 

video scaler, cropping and borders. The independent control of these three 

units has been done so the user can achieve not just standard DVE squeezes, 

but wipes as well. 

Scaler 

The scaler control is responsible for resizing the video. You can resize the 

video along 2 axis – X & Y. The best way to understand how it works it to 

use it in practice.  

 

 

 

The position of the video is specified by controlling the top left hand co-

ordinates and the bottom right co-ordinates. This has been done to make it 

easier to perform wipes. Example: 

 

 



Media Conversion Software DVE Editor 

Miranda Technologies Ltd  Page 129 

Mask 

The Mask Enable check box allows the user to enable or disable the mask. 

When it is disabled no video will be seen on the chosen channel. The mask 

soft edge sliders allow the user to increase the size of the soft edge.  The 

mask transparency is used to change the transparency of the video. 

 

 

 

Mask Layering 

Using the panel below you can change the order in which Channel 1 is 

displayed with reference to Channel 2.  
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Mask Cropping 

You can crop the video 4 ways. When the sliding bars are at full extent, the 

video will be fully cropped in that direction. The panel has a check box 

which allows you to link the cropping with the scaler size.  

When the mask is not linked to the scaler it can be used to perform transition 

effects such as wipes. Below is a screen grab which shows the mask being 

used.  
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Border 

Use this panel to enable and disable the border effect. If the effect is enabled, 

the sliders can be used to define the thickness of the borders. 

 

 

Border Colour 

Use this panel to define the border colour. You can either use the sliders to 

define the colour using the YUV colour space, or select a colour using the 

standard Windows colour picker. 
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Border Position 

Borders can be independently controlled regardless of the position size of the 

scaler. To link the border position to that of either the scaler or the mask, 

click the appropriate Lock option.  

 

 

Movement 

Selecting the various movement options will change how the current 

keyframe will be morphed from the previous keyframe. When settings these 

always ensure you load a keyframe first. Experiment with the settings until 

you get the desired result.  
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Panning 

Use this panel to pan either the video or the border effect. 

 

 

Saving Keyframe Changes 

To save the current keyframe, press the Save button in the keyframe preview 

panel. 

 

Note that saving a keyframe only saves it to a temporary workspace,  to store 

the changes permanently the user must save the sequence as well.  
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Tutorial: A over B squeeze back 

This tutorial will show you how to design and save a sequence from scratch 

to perform an A over B squeeze move. Once your sequence is designed, you 

can then go back and modify it as many times as you like and generate more 

sequences from it. Although the example is designed for using the DVE 

option for Imagestores 2 and 300, the same principles apply to using the HD 

and 750 Imagestore models. 

 

                              
 

 

1. Ensure you are connected to the Imagestore (check the colour of the 

Connect button). 
 

2. Now find an unused sequence slot in the higher sequence numbers. 

If the slot is unused, it should contain no keyframes so that the 

Keyframes panel is left blank. 
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3. Now reset both video channels so we know we’re starting full 

screen.  

 

 

 

 

 
 

 

4. You should now see either channel A full screen or channel B full 

screen. Toggle the video layering a few times to see the affect it has 

on the output. When you’ve finished set the layering to ‘Channel A 

on top’. 

 

 

5. You should now have channel A full screen, and channel B should 

also be full screen, but just behind it. 
 

                                       

 

 Click both of the following 

Toggle between Channel A on top, and 

Channel B on top to see how it affects the 

output.  
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6. For this sequence we will need two keyframes. Click on either of the 

Insert buttons twice and two keyframes should be added. The panel 

should now look like this: 
 

 
 

7. We now have a sequence which looks like this: 
 

                               Keyframe 0            Keyframe 1 

       
 

8. Set the duration between the two keyframes to 50. This means the 

sequence will start and take 2 seconds to go to Keyframe 1. 
 

 

 
 

 

Type in 50 for the duration. 

Insert two keyframes.  



Media Conversion Software DVE Editor 

Miranda Technologies Ltd  Page 137 

9. We now have a sequence which looks like this: 
 

           Keyframe 0                                    Keyframe 1 

                                              

 

 

10. The sequence is almost completed now, we just need to resize the A 

video on the second keyframe to reveal channel B. To do this, 

ensure that the second keyframe is selected and use the positioning 

panel to resize channel A.  

 

 

 

 
 

 
 

2 seconds (PAL) 

Reducing the position on the  

z-axis will make channel A smaller 

 

Ensure this is selected so that when altering 

the position, it changes channel A. 
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Adjust the position of channel A, until it achieves the desired look, e.g.: 

 

 
 

11. Now save this keyframe by selecting the Save 

option. 

 

 

 

12. Press the play arrow button and your sequence should now do the 

following move over 2 seconds: 
 

                    
 

To play the sequence in reverse, press the reverse button: 

 

                   

 

13. The final stage is to save the 

sequence: 
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Working offline 

This option is currently only available when using HD and 750 models of 

Imagestores. 

 

The DVE editor can be used to create sequences without having access to an 

Imagestore. The sequences can be saved to the local hard drive and later 

downloaded to the Imagestore. To use this feature, select the either the ISHD 

or IS750 option in the top-right corner of the application: 

 

 

 

That will display the options to load and save sequences to and from disk: 

 

 

 

You can now create a sequence in the usual way and use the Preview area to 

get an idea of how your sequence will look. You can then save it to your 

local disk or networked drive. 

 

At a later stage when an Imagestore becomes available, connect to it and 

select a sequence that you would like to overwrite with your new sequence. 

Then select the Load option and your sequence will be downloaded to the 

Imagestore. 
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Managing Sequence files 

Using the editor it is possible to upload and download sequence files between 

multiple Imagestores and the PC.  

 

 

 

 

 

 

 

 

 

 

 

 
 

Using the above form you upload/download single sequences or multiple 

sequences in one go.

Imagestores 

Network 

 

PC 
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Configuring TCP/IP Networks 

This section describes how to set up PCs running Microsoft Windows 

operating systems for networking with Miranda Technologies Ltd. 

Imagestores. 

 

There are four components requiring correct setting up of networking. 

 

• The Ethernet cabling 

• The Miranda Technologies Ltd. Imagestores 

• The TCP/IP networking on the Windows PC 

• The Miranda Technologies Ltd. software (MCS or MDS) running on 

the PC. 

The configuration of each of these areas is described separately. 

Ethernet cabling 

The PC communicates with the Imagestores over an Ethernet network. 

Ethernet networks can be large and complex and the final configuration will 

probably come down to personal preferences or corporate policy. 

Imagestore units can operate with either 10Base2 (Thin Ethernet) or 10BaseT 

(Twisted pair Ethernet). Imagestore IS2 and Playstore units can automatically 

sense which connection is in use, while Imagestore IS1 and Imagestore 

Upstream require factory reconfiguration to be switched to 10BaseT (the 

default is 10Base2). 

10Base2 networks have the advantage of requiring fewer active components. 

No hubs are required and the coax cabling can make daisy-chaining multiple 

units easy. However, a cable fault anywhere in the chain can cause the entire 

network to fail. In addition, confusion can occur between 50 Ohm cabling, 

tee-pieces and terminators required for 10Base2 and 75 Ohm ones used for 

broadcast video. 

10BaseT networks require additional multi-port hubs to join units together. 

However, the cabling is usually cheaper than coax and individual units can be 
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removed or added to the network without interrupting the network cabling. 

Individual cable faults will usually only cause small areas of the network to 

fail, are more easily located. Also, use of Cat. 5 twisted pair cabling means 

the network can be more easily upgraded to 100 Megabit Ethernet at a later 

date. 

The ideal configuration for large installations may well be a mix between the 

two different technologies. 

Miranda Technologies Ltd. recommends keeping your PC and Imagestore 

network separate from any other corporate networks you may have. If you do 

need to join them together – for example to transfer graphics into the PC 

system from graphics department PCs, then an intelligent bridge/router 

should be installed between the two networks to reduce unnecessary network 

traffic. 

Miranda Technologies Ltd. recommends keeping the number of passive hubs 

and repeaters between your Windows computers and the Imagestores to the 

minimum necessary. Failure to do this can lead to degradations in network 

performance. 

Imagestore Configuration 

Imagestore units must be fitted with the Ethernet option available from 

Miranda Technologies Ltd. Units fitted with this are easily distinguished by 

the presence of the Ethernet Coax (and optionally, RJ45) connectors on the 

rear of the unit, just to the right of the AC power connector. For Imagestore 

IS2 and Playstore units, a license code must be installed on the unit to enable 

use of the Ethernet. 

IP Address and submask 

Each Imagestore is allocated a network identifier (IP address). A unique IP 

address is allocated at the factory. This may need changing to conform to 

local networks and should only ever need altering in the field if the network 

were reconfigured or joined into other corporate networks. 

If you are required to change the IP address or submask values, consult the 

manual for the unit in question.  
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10-BASE2 and 10-BASET Cabling 

Unless requested otherwise, Imagestore IS1 units with Ethernet options are 

set up to use 10-BASE2 (Thin Ethernet) connections.  

Imagestore IS1 systems (white front) typically require factory re-

configuration to allow use with 10-BaseT (Twisted Pair) Ethernet.  

Imagestore IS2 and Playstore systems have auto-sensing network cards, 

which automatically switch between the 10Base2 and 10BaseT ports.  

Configuring Windows TCP/IP Networking 

The MCS software is designed to run on a Personal Computer running 

Windows NT 4.0 or Windows 95/98/2000. The network protocol used is 

TCP/IP, which may need to be installed and configured to run on the 

Windows system. 

Installing an Ethernet card in your PC 

Because of the range of different cards available, this is outside the scope of 

this document. Consult your IT department or other Networking specialist for 

assistance. 

IP Address 

The IP address of the MDS computer is specified by Miranda Technologies 

Ltd. the factory and should not need to be changed. If you are installing MDS 

software on your own computer, then your network administrator should 

provide you with an IP address and submask value. 

Installing the TCP/IP Network Protocol 

Software 

Due to the complexities involved and the wide range of possible set-ups, this 

document can only give a broad view of the procedures to follow. Your IT 

department or other Networking specialist should be your first point of 

contact for assistance. 
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From the Start button, select Settings, then Control Panel. From Control 

Panel select Network. The following dialog box will appear: 

 

 

Click on the Protocols tab to display the following dialog box: 
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Now click the Add button to display the following dialog box: 

 

 

 

Choose TCP/IP Protocol from the above screen to display the following 

screen:  
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Select the network adapter from the list, click next to Specify an IP address 

and then add the IP Address and Subnet Mask. The values given above are 

merely examples, since the values are specific to a particular installation. 

However, for a stand-alone network of Miranda Technologies Ltd. units 

based on factory-set IP addresses, the IP address should be in the range 

10.96.xxx.xxx or 179.1.xxx.xxx for older systems with the Subnet mask 

shown above of 255.255.0.0. 

The hosts file 

Windows NT provides the TCP/IP network services used in image file 

interfacing on the MDS computer. Each Miranda Technologies Ltd. unit 

connected to the MDS system via the network has its own identification 

number known as an IP Address. The MDS system also requires an 
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identifying IP address. The allocation of IP addresses to particular Miranda 

Technologies Ltd. units is typically made at the factory. 

Since IP addresses are not particularly user-friendly (hard to read and 

remember, easy to mistype), there is a text file used by Windows NT and the 

TCP/IP software which contains lists of IP address numbers with 

corresponding textual names. These names may be specified by the user - to 

better reflect the kinds of units used on the MDS network - by editing the 

‘hosts’ file. (The file is called hosts, since a host is synonymous with 

computer in TCP/IP terminology). 

Example of a ‘hosts’ file entry: 

176.1.1.23 CHAN9_STILLS # C9’s Still Store 

where: 

1. 176.1.1.23 is the IP address 

2. CHAN9_STILLS is the unit name (in this case based on the chassis 

number) and 

3. # C9’s Still Store is a comment, since it starts with the hash (#) symbol. 

The hosts file is located in the drivers\etc subdirectory under the Windows 

NT system directory. The full path is typically: 

c:\winnt4\system32\drivers\etc\hosts 

There should be an individual entry for each Imagestore on the network. 

MCS System Configuration 

Introduction 

The environment for the MDS system is determined by the contents of three 

files 

1. The hosts file  

2. The units.txt file 

3. The Miranda Technologies Ltd.ini file 
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The hosts file 

The ‘hosts’ file is described in the section above. The MDS application 

software makes use of this file to find the corresponding IP addresses from 

the user’s textual unit names. 

The units.txt file 

The names of the Imagestores on a network are held in a file called units.txt 

which is plain, editable text that can be modified by the user. 

The units.txt file is located in the drivers\etcsubdirectory under the Windows 

NT system directory, along with the hosts file. The full path is typically: 

c:\winnt4\system32\drivers\etc\units.txt 

This file may be edited by using the notepad application, or any other simple 

text editor. 

Example of a units.txt file contents: 

KEYER_1 

KEYER_2 

STILL_STORE_1 

STILL_STORE_3 

GRAPHICS_UNIT_1 

 

The following restrictions apply to the format and contents of the units.txt 

file: 

1. Only one unit name per line 

2. No spaces allowed in unit names 

3. No blank lines 

4. The very last unit name must have a return at the end, otherwise it will 

not be seen 

The network addresses of the Imagestores are linked to their names using the 

hosts file. That means that for every unit name given in units.txt, there must 

be a corresponding entry in the hosts file. 
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Support  

Product Support 

Miranda Technologies support desk exists to provide timely help and advice 

to users and telephone support is available for the entire life of the product. 

The support desk may be contacted at any of the following locations. 

 

Americas 

Telephone: +1-800-224-7882 

techsupp@miranda.com 

 

Asia 

Telephone: +81-3-5730-2987 

asiatech@miranda.com  

 

Europe, Middle East, Africa, UK 

Telephone: +44 (0) 1491 820222 

eurotech@miranda.com 

 

France (only) 

Telephone: +33 (0) 1 55 86 87 88 

francetech@miranda.com 

 

 

Where the query relates to a specific product, make a note of the unit's serial 

number (on the rear panel) and the software version (displayed on the front 

panel at boot-up). 
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Warranty and Non-Warranty Repairs 

Miranda Technologies Ltd provides all products that are sold new with a two-

year, return-to-base warranty. Products that are purchased as “ex-demo” may 

have a limited warranty and reference should be made the original 

acknowledgement of order or the Product Certificate for warranty details. 

A repair service for warranty and non-warranty products provides a typical 

turnaround time of ten working days. The procedure for returning a unit to 

Miranda Technologies Ltd is given later in this section. 

Obsolescence 

Obsolete products will be supported for a minimum of 3 years from the date 

of obsolescence. Miranda Technologies Ltd will continue to provide support 

beyond this period, but will not replenish service stock and is therefore 

unable to guarantee the availability of every component used. 

Upgrades 

Software upgrades are regularly available as part of a continuing commitment 

to product improvement. Most software upgrades can be performed remotely 

and customers are kept informed of software and hardware upgrades via 

Release Notes that are e-mailed to the nominated contact. 

Hardware upgrading is normally carried out at Miranda Technologies Ltd’s 

factory and involves full re-testing and QA checks. Refurbishment can also 

be performed where required but these are not covered by the standard 

warranty. 

Service Visits 

On-site assistance from a Miranda Technologies Ltd Field Service Engineer 

will be provided assuming adequate notice is given. Service visits are 

normally chargeable and are not covered by the standard warranty. 
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Equipment Loans 

A variety of loan agreements are possible and can be arranged with the 

Engineering Support department through the helpdesk although it is not 

always possible to fulfil loan requests at short notice. 

Training 

Customer training can be provided to match individual requirements. 

Training can be carried out either at customer premises (preferred option) or 

at Miranda Technologies Ltd’s facility in Oxfordshire where a dedicated 

demonstration room is available. 

Courses can be tailored for either technical or operational staff and these 

courses can be ordered at the same time as the equipment or at any 

subsequent time. 

Web Page 

Miranda Technologies Ltd’s web page can be found at www.miranda.com. 

Returns Procedure 

Should there be a need to return any Miranda Technologies Ltd product for 

upgrade or repair, telephone the Helpdesk and request a "return number". 

The helpdesk will ask for details of the return including the unit’s serial 

number, reason for return and any fault information. Make sure that these 

details are to hand when contacting the helpdesk. 

Mark the “return number” clearly on any packaging as well as on the return 

paperwork. Any subsequent correspondence should reference this “return 

number”. 

Transit Packaging 

When returning equipment ensure that it is adequately packaged using good 

quality materials. Particularly ensure that the unit is tightly packed within a 

strong carton (preferably the original) and avoid common polythene or 

polystyrene chips, since the product may contain static sensitive devices. 
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Some components, such as hard drives, may be susceptible to damage by 

physical shock and caution is required when removing the equipment from 

racks. 

Units received at Miranda Technologies Ltd with obvious damage, not 

described on the accompanying documentation, or not notified to Miranda 

Technologies Ltd by the customer, are assumed damaged in transit and this is 

chargeable. Customers are strongly advised to insure the equipment against 

damage in transit when returning it to Miranda Technologies Ltd. Should a 

unit be received from Miranda Technologies Ltd in a damaged state (either 

new or repaired), this should be reported to both the courier and Miranda 

Technologies Ltd immediately 
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Appendix A – 10Base2 Network 

Cabling and Installation 

1. IEEE 802.3 10Base2, 10 Megabits per second 

2. Cable type is 50 Ohm coaxial, also known as Thin Ethernet (RG58, 

Belden 9907 type or equivalent) 

3. Daisy-chain cable connection via 50 Ohm BNC connectors and a ‘T’-

piece. 

4. Allow at least 0.5m of coax cable between ‘T’-pieces. 

5. Up to 30 units on a network segment 

6. Maximum length of cable per segment is 185 metres 

7. Fit exactly two 50 Ohm BNC terminators per network segment, one at 

either extreme of the segment cable run. 

8. Maximum number of segments is 5 

9. Maximum total length of cable over all segments is 925 metres 

 

PARAMETER Value 

Taps per segment 30 

Maximum Node Separation 5 segments, 4 repeaters 

Maximum Segment Length 185m 

Network Span 925m 

Min. Separation Between Transceivers 0.5m 
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Appendix B – Windows 95/98 

Installation 

MCS software can run under Windows 95/98. Because of the lack of security 

within the Windows 95 environment, Windows XP and 2000 are preferred. 

Installation is broadly similar to the Windows 2000 and XP configuration, 

but file locations will change as follows. 

The hosts file must be in the directory C:\WIN95. 

The units.txt file must be in the C:\WIN95\SYSTEM\DRIVERS\ETC 

directory. Create the subdirectories shown, as they will not normally exist on 

a standard Windows 95 installation. 

 

 


